
AWIPS Build 4.2 D2D software release notes 
These are changes from Build 4.1. 

 
Note:These are working notes on FSL's part of the Build 4.2 work. Some items may be modified 

or removed before Build 4.2 hits the field. Official Release Notes will be posted at the NWS 
AWIPS site once the field release is ready. 

 
 

Infrastructure 
• A log can now be kept of each localization session, including a list of changed files and a 

record of actions. This log is enabled if environment variable 
FXA_LOCALIZATION_LOG is defined. A help file for localization is now also 
available, displayed if mainScript.csh is run without any arguments or a -h.  

• WarnGen now supports the partial-CWA backup concept.  
• MRF grids are now included to support Hawaii and Puerto Rico localizations. Alaskan 

MRF, NGM, and Eta grids are also available.  
• The storage location for Redbook graphics has been changed. An invisible effect is that 

purging of these products can now be done much more efficiently, thereby saving system 
resources. A visible effect is that the available number of versions is better controlled.  

• A radar archive capability is included in the system. Control is from the Archive 
Manager... selector at the bottom of the Radar menu. Selected radar data can be saved to 
tape and replayed at a later time.  

• Observations and Official User Products are also stored in protected disk directories (for 
7 and 31 days, respectively), to satisfy legal requirements. (And as in 4.1, all locally-
generated text products are saved for 31 days.)  

• Additions to the process monitor are a restart capability and a CPU monitor which tracks 
CPU usage on the data and application servers and the workstations.  

• The disk space part of the data monitor also now includes some workstation partitions.  
• localization/nationalData now is shared on /data/fxa to save space in the /awips partition 

on each server and workstation.  
• Text products are now transmitted via the WAN. Those addressed to "DEF" go to the 

NCF for distribution. Watches, warnings, and advisories are distributed over the WAN, 
while others go on the SBN. A product can also be addressed to a specific site.  

• When in storm mode, a subset of radar products is sent to NCF via the WAN. These are 
then sent out over the SBN. The RCM and DPA products are also requested from each 
dedicated radar every 30 minutes, and forwarded to the NCF. (Note that these products 
therefore do not go in the RPS list.)  

Graphics/image workstation 

New features 



• A 15-minute METAR plot is added to the menu on the State(s) and Local scales.  
• Data from ships and moving buoys is now available, in addition to the fixed buoys 

previously on the menu.  
• The AWIPS Quality Control and Monitoring System (QCMS), which quality controls 

LDAD and NOAAPORT surface observations, has been upgraded to quality control 
additional meteorological variables more frequently, and also now includes temporal and 
internal consistency checks, in addition to the validity and spatial consistency checks 
utilized in Build 4.1. 
Also new in Build 4.2 is the ability to display LDAD QC information along with the raw 
observations. The QC displays consist of two overlays simulating color-coded station 
plots. Stations with observations found bad by the QCMS are distinctly colored to 
indicate possible problems with their reported data. Sampling any station invokes the 
display of a small QC table indicating which QC checks have been applied at the time of 
the display, which ones have been passed, and which ones have been failed. Plots are 
automatically updated as new observations arrive and are quality controlled.  

• WWA... is added to the Tools menu, to call up the WWA component of ICWF.  
• Radar items:  

o When a radial product is displayed, a new pop-up menu item allows you to select 
high-resolution zoom. When enabled, the mapping table for zoom is computed on 
the fly, rather than using the pre-generated, standard-resolution, table. In high-res 
mode, the zoom will take a few seconds (for the first frame), but radials' pixels 
will be more accurately shaped.  

o Cell trends graphics are added to the radar menus. In the initial implementation, 
you select a storm by placing one of the Points near it, then you display the trends 
graphic by picking "xxxx Cell Trends X" from the menu. Once a storm is 
associated with a named point, it will auto-update the display, even if the storm 
moves away and another moves over the point. A clear and redisplay will again 
choose the closest storm to the named point.  

o It's now possible to display Digital Precipitation Array (DPA) data from 88Ds.  
o New Build 10 products APR and CFC are added to the menus.  
o You can now request the Severe Weather Analysis package via the one-time 

request application. This of course actually constitutes several product requests: 
SWR, SWV, SWW, and SWS.  

o Some new radar text products are also available. See the Text section below for 
details.  

• A new interface to LDAD acquisition/dissemination is added, accessible from the LDAD 
section of the Surface menu. The old LDAD xmain GUI is also now available from the 
Surface menu (via selector "LDAD DB Maintenance..."), but the collection and 
dissemination parts of it are now handled by the new GUI.  

• If a review case is being run, appropriate indication is made in the main window title bar.  
• User color table management has been modified. As in previous builds, a set of color 

tables is delivered with the system (as noted below, expanded in 4.2), and local custom 
color tables can be created, stored, and used. Previously, however, a set of user-defined 
tables was kept on each workstation. Most offices manually copied the custom color file 
to all workstations, so that each station had the same setup. Some, however, kept different 
sets of tables at the various workstations. 



In Build 4.2, there is now a central, office-customized file that is available to all 
workstations. In addition, each user can save tables under his or her name, just as is done 
with procedures. (In fact, the procedures list will show a "colorTables" entry, which is 
not a procedure but the directory in which the color tables are stored.) From the color 
tables editor menu, use the Office Save As... button to write to the central list and Save 
As... to write to the user list.  

• ECMWF grids are now ingested and available for display.  

Improvements 

• Several changes have been made to the Volume Browser:  
o Time sections are now accessed by setting the Browser state, instead of being one 

of the button-two choices on the product listing. The mode is now set with an 
options menu, so the current setting can easily be seen. Other options menus 
appear, and the structure of the source/field/level menus adjust, based on the 
mode selected.  

o The Field pull-downs have been reorganized. A few items have been moved, but 
the main change is that Other has been split into Sfc/2d and Other, where the 
former includes items that apply to only one level (most at the surface), and 
cannot be used for cross sections. (The Sfc/2d menu does not appear if you select 
cross section mode.)  

o New Pressure advection and column max reflectivity fields are added to the 
menu.  

o A surface omega field is added to the menu, computed using wind and terrain.  
o On the Northern Hemisphere scale, a new data source is GWW - the global wind-

wave model. Fields available include wave height, wind wave direction and 
period, and primary and secondary wave direction and period.  

o Alternate vertical scalings are available for cross sections. These include linear 
pressure and different max/min pressure limits.  

o All Volume Browser tear-away menus can be closed by selecting File>Close 
Browser Tearaways.  

o The row of buttons just above Load has been removed. Diff is moved down next 
to Load, since it really means "compute difference and load," and the functions of 
the other buttons (Clone, All, None, and Clear) are all accessible through the File 
and Edit pull-downs. The load modes option menu has been removed, since it's 
available on the main D2D control bar.  

• Radar items:  
o Default color tables can be assigned for radar products as part of localization. 

Choices and defaults are Z (20), 3 (21), V (19), V3 (39), 8 (35), and H (40). 
Eleven new PUP color tables are also now available on the standard list.  

o The RPS list editor window now displays the maximum number of products that 
may be placed on the list, and limits entries to that number.  

o Radar menus now include 4-panel SWA products.  
o Time matching for mosaics is handled better. Each component is placed in the 

closest 6-minute time bin.  



o The alert request application has been enhanced to accommodate sites with 
multiple associated radars.  

o The Alert Cancelled message no longer generates a red banner. It is logged as a 
significant (flashing) message, instead of urgent.  

o A new Radar multiple request... selector is added to the radar applications 
section of the menus. It complements the previous (and remaining) One-Time 
Request application, and allows you to schedule a recurring request, or make 
requests from multiple radars.  

o Descriptive labeling for graphics is improved.  
o The VAD and VWP (VAD Wind Profile) products are now multicolor graphics.  
o A new USRA (user-selectable total precip) product is available on both standard 

and mosaic menus.  
o It's now possible to display the current list of products (PTL product). This is also 

stored in the text database under WSRPTLxxx, where xxx is the radar ID.  
o The Extended TVS (ETVS) display is now available. (Different symbols are 

used.)  
o The menus for the One-Time Request and RPS list editor have been updated to 

conform to the style used in other D2D menus.  
o You can now assign a priority code (Low or High) to product requests. Also, the 

parameters you set on a request will be preserved from one use to the next.  
o AGL height information is improved via access to better topography. Height 

readout now also includes MSL.  
o VCP and data information is now plotted at the upper-left corner of radar images 

(and at the upper right for the second half of a combined image). This includes 
such things as max reflectivity, min/max velocity, max precip, precip bias/error, 
and precip accumulation start/end times.  

• The File>Procedures menu item to put the current bundle into procedures now reads 
"Copy Display to Procedure(s)". The keyboard accelerator for this function is still 
Control-B. (Click here to see a table of all keyboard accelerators.) Note: new in Build 4.2 
is case insensitivity in the keyboard accelerators. In 4.0 and 4.1, if you happened to use 
capital B, for example, as shown on the menu, the accelerator did not work.  

• WarnGen items:  
o Pathcast algorithms are improved.  
o Start and end times are now specified for some warnGen products.  
o The main dialog layout has been modified to more logically group various 

buttons, and to make optional bullets more accessible.  
o There are now two CWA selectors in the warnGen dialog. One selects a partial 

adjacent CWA, supporting the coming service backup concept. The other, labeled 
"Full", selects the whole CWA. When one of these is selected, it will be colored 
yellow as a reminder to the user that backup mode is engaged.  

o WarnGen has been revised to accommodate Valid Time and Event Code (VTEC). 
At present, templates to effect the change have not been developed.  

• A new marine zones map is now available.  
• The lat/lon map now includes some labels.  
• Several Redbook graphics have been added to the menus: 

Surface obs  



NA MSL pressure and fronts 
day 3-5 fronts and pressure is now separated from fronts/pressure analysis 
WATL and EPAC wind/wave 
sig wave height 
primary wave direction 
primary wave period  

Models  

MRF MSLP 
NGM MOS  

12h PoP 
max/min isotherms 
max/min plot 
solar energy 
hours of sunshine 
% sunshine  

Upper Air  

MRF height 
0-240 hr panels, vice the former 120hr only, for MRF and AVN 
Trajectories:  

NGM surface, 850, and 700 parcels 
sfc, 850, and 700 Td 
12h vertical displacement 
K index  

• Product Maker items:  
o A new layout is provided for the Product Maker UI.  
o Product Maker fields can be placed in procedures.  
o The Product Maker now includes the ability to filter data above or below 

specified thresholds. For example, you can contour temperatures below freezing 
only.  

o A new button-3 popup option is available over Product Maker product legends: 
you can toggle on a display of the equation used to build the product.  

• Pacific-area RAOBs are now plotted, and are on the skew-T menus. The skew-T menus 
now also include the station name, in addition to 4-character ID.  

• Color tables in four-panel displays now can be assigned independently.  
• Custom color tables are now stored with bundles.  

Bug fixes 



• Torn off menus now can be pushed behind the main display. They also can be 
independently iconified. Also, the titles of these are again properly set (no more 
"tearoff13" names). [This latter I think was introduced in 4.1, but I can't check on that 
right now.]  

• BLDU obs on METARs now correctly plot an appropriate symbol.  
• In Build 4.1, if you loaded a multiload containing a gridded overlay and an interactive 

overlay with the load mode set to Previous Run, it would crash the display. No more.  
• Four-panel charts can now be printed. [This is not yet implemented, but initial work has 

begun, and is to be finished for 4.2.]  
• A half-cell error in sampling has been fixed. The main effect of this is that samples 

should reflect the data under the tip of the pointer arrow, rather than somewhere in the 
middle. [This fix may be pushed back into 4.1, at which time this item needs to be pushed 
back into the 4.1 release notes.]  

• Fixed bug that manifested itself when the user selected a new scale. The green times 
would not update to show the availability of products, which was a problem in the case of 
a few menu items that at different scales represent different products.  

• Radar cross sections now sample correctly.  
• If you have more than one dedicated radar at your office, you may have run into the 

problem in 4.1 that the alert areas were sent to all radars, not just the one selected in the 
Send command. The upshot of this was that you could have only two areas for all of your 
radars. This is fixed, and you can now have two areas for each radar. (See below in the 
New Bugs section for a note on the opertation, though.)  

• Flash Flood Guidance plots now are in order 1hr, 3hr, 6hr from top to bottom.  
• LDAD data now plot correctly at 15-minute intervals.  

Remaining bugs 

• The default load mode (Valid Time Sequence or Latest Model Run) is restored after a 
swap, instead of whatever mode you had set when that information was in the large pane.  

• Once you're in 4-panel mode, you stay there until explicitly Clearing the screen. If you 
select products on a different scale, you'll get the same thing loaded in each panel.  

• Samples on skewT charts include a degree sign in front of K.  
• You can't individually magnify the VR shear overlay (from the pop-up menu). (It will 

magnify if you do a global magnification from the menu.)  
• If you turn lat/lon readout on, then bring up a skewT and sample it, you'll get lat/lon info 

for the previously displayed map (in addition to the chart information that you want). The 
pop-up correctly does not include the lat/lon toggle button, so you can't turn it off.  

• Sounding plots are computing bad wet-bulb zero heights near the surface when there 
should be no wet-bulb zero crossing.  

• The Product Maker provides access to satellite images only on the Northern Hemisphere, 
CONUS, and Regional scales.  

New bugs 

• The map backgrounds menu no longer responds to scale changes. That is, selectors for 
maps that are not available on a given scale don't dim the way they did in previous builds.  



• If you select MSLP as the field in the Product Maker, you must select a(ny) pressure 
level, in order to display it.  

• When as1 fails over to as2, you see a red banner that tells you so, and says that you may 
need to restart in order to continue to get auto update and product time updates on the 
menus. In fact, this is not necessarily the case. To minimize the disruption for restarts, 
you should monitor radar or other frequently-updated products to see if you are getting 
notification of new products (display or menu update). Only if not should you restart the 
workstation.  

• A torn-away Product Maker Source menu does not respond to scale changes. This can 
lead to one selecting a model source that is invalid for the scale.  

• This is not really a bug, but the way the alert area request application works may be a 
little confusing. 

The alert area request can display/edit only two areas at a time, one Area 1 and one Area 
2. They can be for the same radar or, for those sites that have more than one dedicated 
connection, for different radars. For example, you can use Area 1 for radar A and Area 2 
for radar B. However, if you start with Area 1 for radar A and then try to display/edit 
Area 1 for radar B it won't work; you must first clear the display and select another radar 
if you want to display/edit another Area 1.  

 

Text workstation 

New features  

• On the File menu, you'll now find a "Request from Remote Site..." item.  
• Products are checked for duplicate storage in the database. All products received whose 

WMO origin matches the local site (as specified in environment variable 
FXA_LOCAL_SITE) are checked for duplicates before being stored. In addition, the site 
may add other files to be checked by placing their AFOS PILs in file 
/awips/fxa/data/checkProductFile.dat on ds1 (and ds2 for failover).  

Improvements 

• The editor dialog buttons have changed. The former "Save & Exit" button has been 
renamed "Send", because it saves to the database, sends to AFOS and/or the WAN, and 
leaves the editor. A new "Save" button allows you to save changes to the database, 
without sending them to AFOS or the WAN.  

• Observations are prepended with "METAR" or "SPECI" as appropriate.  
• Though the METAR help mechanism still uses 3-character IDs (see the bugs list below), 

ambiguous station IDs now show both the K and P information (e.g., ABR K-Aberdeen, 
SD; P-Barrow/Post-Rogers, AK).  

• The text window background color is now light gray instead of bright white.  
• A new afosMasterPIL.txt file means that the text browser better represents the contents of 

the database. New products (such as those associated with realignment of forecast areas) 



may not be included in the afosMasterPIL file, and thus won't appear in the browser. 
Some other items may simply have been overlooked, and thus are not accessible except 
via command line. 
The categorization of products in the browser menu has also been improved, so NNNs 
should be more logically located. In addition, much of the help information has been 
updated, so most CCCs, NNNx, and XXXs show reasonable help fields.  

• AWIPS Change Notices, previously stored as PNSWSH, now store under 
WSHPNSWSH.  

• LAMP forecast matrices (FLP products) are now included in the text browser under 
National Guidance.  

• The suite of radar text products has changed. All radar text files store under names 
WSRNNNXXX, where NNN is shown in the table below, and XXX is the trailing 3 
letters of the radar ID.  

Description 4.2 ID 4.1 
VAD Wind Profile VWP same 
Mesocyclone MES same 
Storm Track Information STI same 
Hail Index HAI HIA 
Tornado Vortext Signature TVS same 
Combined Shear CSH same 
Combined Shear Contour CSC not avbl 
One-Hour Precip OHP same 
Three-Hour Precip THP same 
Storm Total Precip STP SPT 
User Alert Message UAM same 
Radar Coded Message (unedited) RCM same 
Free Text Message FTM same 
Storm Structure SST same 
Supplemental Precip Data SPD not avbl 
Product List PTL not avbl 

Bug fixes 

• When you Cancel an eLog entry, the eLog window now closes.  
• In the text browser, NO DATA is now displayed for products missing from the database. 

Previously, either the time from the last good product above in the list, or "20:45 Dec 13" 
was indicated for most such products.  

• A:HH CCCNNN now works properly.  
• Torn-away Edit menus now respond to changes in the edit state.  



• In previous builds, text from dial radars stored in the database as WSRNNNxxx, and 
could not be retrieved because of the lower-case xxx. These now store correctly as 
WSRNNNXXX.  

New or remaining bugs 

• The WarnGen window occasionally doesn't pop up automatically. Workaround: Request 
WRKWGx from any window. (The warning expiration reminder won't work in this case.)  

• The text subsystem still uses 3-character station IDs. As a result, the Help function in the 
browser and the button-2 popup station ID info on METAR messages can't distinguish 
between Kxxx and Pxxx. Usually, both are shown, leaving it to the user to figure out 
which one applies. In some cases, erroneous IDs show up.  

• The text database distinguishes products by length. "Long" products (> 2000 bytes) are 
stored in a separate part of the database, and must be defined as such; if a product 
exceeds the limit, but is not specified on the list of long categories, it will be truncated. 
Your AWIPS Focal Point can move products to the long-products storage area.  

• Like many other products, pilot reports come in a collective and are stored under the site 
id instead of your local CCC. Thus, a pilot report referenced to DHN would be stored as 
BHMPIRDHN. Some erroneously get stored by 2-letter state ID under your local CCC, 
e.g., PIRAK. Most of the latter are duplicated in the site-ID style.  

• The "ss.NNN" construct does not work.  
• When you add a product to the alarm/alert list, it will not do so the first time it is 

received. If you click twice on "Save and Exit" it will trigger the alert the first time. 
Similarly, to effectively remove an item from the list, it's necessary to click "Product 
List" after "Save and Exit."  
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